Warranty and Service Policy

Product Warranty

DATAQ Instruments, Inc. warrants that this hardware will be free from defects in materials and workmanship under normal use and service for a period of one year from the date of shipment. DATAQ Instruments' obligations under this warranty shall not arise until the defective material is shipped freight prepaid to DATAQ Instruments. The only responsibility of DATAQ Instruments under this warranty is to repair or replace, at its discretion and on a free of charge basis, the defective material.

This warranty does not extend to products that have been repaired or altered by persons other than DATAQ Instruments employees, or products that have been subjected to misuse, neglect, improper installation, or accident.

DATAQ Instruments shall have no liability for incidental or consequential damages of any kind arising out of the sale, installation, or use of its products.

Service Policy

1. All products returned to DATAQ Instruments for service, regardless of warranty status, must be on a freight-prepaid basis.

2. DATAQ Instruments will repair or replace any defective product within 5 days of its receipt.

3. For in-warranty repairs, DATAQ Instruments will return repaired items to the buyer freight prepaid. Out of warranty repairs will be returned with freight prepaid and added to the service invoice.
The DI-710 data acquisition device you have purchased and are about to use is NOT an ISOLATED product. This means that it is susceptible to common mode voltages that could cause damage to the device. SUCH DAMAGE IS NOT COVERED BY THE PRODUCT’S WARRANTY. Please read the following carefully before deploying the product. Contact DATAQ Instruments Support at 330-668-1444 for all questions.

This product can tolerate a maximum applied voltage of only ±20V peak without damage. Although you may be certain that the signal you want to measure is lower than this level, a common mode voltage (CMV) with an unknown value may combine with your signal of interest to exceed this ±20V limit. In such instances, the product will be damaged. Verify a CMV does not exist before connecting signals and acquiring data with your device. Use the following procedure to check for CMV:

1. DO NOT connect your data acquisition device to the device under test. If the device under test is connected to your data acquisition device, disconnect it.

2. Connect your data acquisition device to the appropriate interface on your PC (USB, Ethernet, RS-232 Serial, or Parallel Printer Port).

3. Apply power to your data acquisition device, your PC, and the device under test.

4. Use a digital voltmeter to make the following measurements:
   a. Measure the voltage (both the AC and DC range) between the ground terminal of your data acquisition device and Signal+ of the device under test. This measurement should not exceed the Full Scale Range of your data acquisition device.
   b. Measure the voltage (both the AC and DC range) between the ground terminal of your data acquisition device and Signal- of the device under test. This measurement should be at or very near 0 Volts.
   c. Measure the voltage (both the AC and DC range) between the ground terminal of your data acquisition device and Common of the device under test. This measurement should be at or very near 0 Volts.

5. Should ANY of these measurements exceed their recommendation DO NOT CONNECT SIGNALS to the data acquisition device. A common mode voltage may exist that could destroy the instrument. You MUST determine the source of the CMV and eliminate it before taking any measurements.

1 Measured signal is not to exceed the Full Scale Range of your data acquisition device.
2 Measured signal must be at or very near 0 volts.
3 Measured signal must be at or very near 0 volts.
4 Connect to AGnd (Analog Ground) port on DI-710 instruments.
# Table of Contents

Warranty and Service Policy .................................................................................................................. iii
CAUTION .................................................................................................................................................. v

## 1. Introduction ...................................................................................................................................... 1
   - Features ............................................................................................................................................. 1
   - Analog Inputs ................................................................................................................................. 1
   - Digital Input and Output ................................................................................................................. 2
   - Software ........................................................................................................................................... 2
     - WinDaq® Recording and Playback Software .............................................................................. 2
     - The DATAQ Instruments Hardware Manager ......................................................................... 2
     - Help ............................................................................................................................................... 3

## 2. Specifications ................................................................................................................................. 5
   - Analog Inputs ................................................................................................................................. 5
   - Digital I/O ....................................................................................................................................... 5
   - A/D Characteristics .......................................................................................................................... 5
   - Scanning Characteristics ................................................................................................................ 6
   - Calibration ...................................................................................................................................... 6
   - USB Interface ............................................................................................................................... 6
   - Ethernet Interface ........................................................................................................................ 6
   - Removable Memory (Stand-alone Models only) ............................................................................ 6
   - Real Time Clock ........................................................................................................................... 6
   - Controls (Stand-alone Models only) .............................................................................................. 6
   - Indicators ....................................................................................................................................... 6
   - Transfer Rate to PC ....................................................................................................................... 6
   - General ............................................................................................................................................ 7

## 3. Installation ..................................................................................................................................... 9
   - Unpacking ....................................................................................................................................... 9
   - USB Device Installation ................................................................................................................. 9
   - Ethernet Device Installation ......................................................................................................... 10
   - Installing an Ethernet Device Directly Connected to your PC or Connected via a Hub or Switch Where ONLY DI-71x Products are Installed ......................................................................................... 12
   - Installing an Ethernet Device via a Distributed Network Without a DHCP Server .................... 15
   - Installing an Ethernet Device via a Distributed Network with a DHCP Server ............................. 16
   - Activation of WinDaq/High Speed Option .................................................................................... 16
   - Dataq Instruments Hardware Manager ......................................................................................... 16

## 4. Instrument Controls, Indicators, and Connections ...................................................................... 19
   - Connecting the DI-710 to Ground ............................................................................................... 19
   - Instrument Front Panel ................................................................................................................. 20
     - 37-pin D sub connector ................................................................................................................ 21
   - Instrument Rear Panel .................................................................................................................. 22
   - Connecting Signals ....................................................................................................................... 22
   - Controls and Indicators ................................................................................................................ 23
     - Power Input Jack ........................................................................................................................ 23
     - Ground ....................................................................................................................................... 23
     - Interface Port ............................................................................................................................. 23
     - Control Button (Stand-alone Models) ....................................................................................... 23
## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Recording</td>
<td>23</td>
</tr>
<tr>
<td>Stop Recording</td>
<td>23</td>
</tr>
<tr>
<td>Formatting the Memory Card</td>
<td>24</td>
</tr>
<tr>
<td>Reconfigure Instrument</td>
<td>24</td>
</tr>
<tr>
<td>Fix Errors</td>
<td>24</td>
</tr>
<tr>
<td>Mode LED Indicator</td>
<td>25</td>
</tr>
<tr>
<td>Removable Storage Slot (SD) (Stand-alone Models)</td>
<td>25</td>
</tr>
</tbody>
</table>

### 5. Operation .......................................................... 27
- PC-connected Models                                         | 27   |
  - Enabling/Disabling the Digital I/O and Remote Control     | 27   |
- Stand-alone Models                                          | 27   |
  - PC-connected operation                                    | 27   |
  - Networked operation as a data acquisition server          | 27   |
  - Stand-alone data logger operation                         | 28   |
  - The Stand-alone Set Up Panel                              | 28   |
  - Operation                                                 | 28   |
  - Troubleshooting                                           | 29   |
- If power down occurs unexpectedly while recording to SD    | 30   |
- WinDaq Waveform Browser for SD                              | 30   |

### 6. Block Diagram ................................................................ 33

### 7. Accessories .................................................................... 35
- The DI-705 (for use with DI-710 “D” models)                | 35   |
- The DI-205 (for use with DI-710 “D” models)                | 36   |
- Input/Output Panel Interconnections                        | 36   |
  - Digital I/O - Analog Output                               | 36   |
- Input Signal Configuration                                 | 37   |
  - Connecting a Single-ended Amplifier                      | 37   |
  - Connecting a Differential Amplifier                      | 38   |
    - Ground-referenced Signal Sources                       | 38   |
    - Isolated Signal Sources                               | 40   |
  - Signal Cable and the Differential Amplifier              | 40   |
1. Introduction

Congratulations on your purchase of the DI-710 data logger/data acquisition system. DI-710 Instruments feature a variety of options—each explained fully in this manual. Options include a USB or Ethernet Interface, PGL or PGH gain settings, and Stand-alone capability. Use the table below to determine the options included with your Instrument.

<table>
<thead>
<tr>
<th>Model No.</th>
<th>Ethernet</th>
<th>USB</th>
<th>-H Gain</th>
<th>-L Gain</th>
<th>Stand-alone</th>
</tr>
</thead>
<tbody>
<tr>
<td>DI-710-UH*</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>DI-710-UHS*</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td>DI-710-UL*</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>DI-710-ULS*</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>DI-710-EH*</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>DI-710-EHS*</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td>DI-710-EL*</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>DI-710-ELS*</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

*All DI-710 models available with a 37-pin D sub connector (as opposed to two removable 16-port screw terminal blocks). Add “D” to the model number. See “37-pin D sub connector” on page 21.

Features

The **DI-710** has the following features:

- Multiple Hardware options: USB or Ethernet Interface; PGL or PGH gain settings; and Stand-alone data logger Operation capabilities. All options available in any configuration.
- Per channel software-configurable settings: Single-ended or differential input; input gain; and calibration.
- 4,800 samples/second maximum sampling rate—up to 14,400 samples/second when recording to a memory card.
- 0.048 samples/second minimum sampling rate—0.0017 samples/second when recording to a memory card.
- 14-bit A/D converter for high resolution measurement accuracy.
- 16-entry input scan list allows you to scan any sequence of input channels at any available gain.
- The Stand-alone option allows the user to configure a recording session through their PC then record data in the field to a memory card (SD) **without** being connected to their PC.

Analog Inputs

**DI-710** models provide 16 single-ended or 8 differential analog inputs (programmable per channel) that allow your analog signals to be converted into 14-bit digital data via an on board A/D converter. Two removable 16 position terminal blocks allow you to easily connect and record signals. The DI-710 features the following software-programmable input measurement ranges:

<table>
<thead>
<tr>
<th>-L Models</th>
<th>-H Models</th>
</tr>
</thead>
<tbody>
<tr>
<td>±10V full scale measurement range at a gain of 1</td>
<td>±10V full scale measurement range at a gain of 1</td>
</tr>
<tr>
<td>±1V full scale measurement range at a gain of 10</td>
<td>±5V full scale measurement range at a gain of 2</td>
</tr>
</tbody>
</table>
Digital Input and Output

All DI-710 models contain 8 software-programmable digital lines (bits) for input/output operations. These lines provide an interface for the transfer of data between user memory and a peripheral device connected to the instrument. Digital inputs can monitor alarms or sensors with TTL outputs, while digital outputs can drive TTL inputs on control or measurement equipment. Remote control can be utilized with bits 0 and 1 and is easily accessed using WinDAQ Acquisition software or, for stand-alone models, in the stand-alone setup panel. To avoid using an analog input channel for Digital I/O, Channel 17 may be enabled as the digital channel. To use the Remote Control features in WinDAQ Acquisition software either Channel 1 or Channel 17 must be configured as the Digital Input channel.

Software

All software required to record and playback waveforms is included with the purchase of any DI-710 model including WinDAQ Acquisition and Playback software and the Dataq Instruments Hardware Manager.

WinDAQ Recording and Playback Software

WinDAQ Acquisition and WinDAQ Waveform Browser allow you to record and playback data acquired through your instrument. Whether using a Stand-alone model or a PC-connected instrument, WinDAQ is an invaluable resource to analyzing your data. A special version (see "WinDaq Waveform Browser for SD" on page 30) of WinDAQ Waveform Browser (free) is required to read waveform data recorded to a Memory Card but is easily transferred to the standard version for more analytical features.

WinDAQ Acquisition software can be used to record waveforms directly and continuously to disk while monitoring a real time display of the waveforms on-screen. It operates and displays waveform signals in real time at the full sample rate of the instrument being used. WinDAQ (free) is restricted to recording throughput rates of 1108 Hz with a DI-710. Purchase an Unlock Code to record data at the speed of your data acquisition system. When you install the software, a trial version of Unlocked High Speed Software is automatically installed allowing you to record at higher rates for a limited time. Activation is required for continued use to ensure compliance with the Software License Agreement. This software is accessed through the Dataq Instruments Hardware Manager which can be found in the Start menu under the WinDAQ program group called Dataq Instruments Hardware Manager.

WinDAQ Waveform Browser playback software (also known as “WWB”) offers an easy way to review and analyze acquired waveforms. A built-in data file translator allows the user to display multiple waveforms acquired by WinDAQ Acquisition software or any of a wide range of data acquisition packages. The software’s disk-streaming design allows data files of any length to be graphically displayed rapidly, in normal or reverse time directions. Seven standard cursor-based measurements, frequency domain, and statistical analysis functions help simplify waveform analysis and interpretation. WinDAQ Waveform Browser is free and installed when installing WinDAQ Software.

The DATAQ Instruments Hardware Manager

The DATAQ Instruments Hardware Manager allows you to effectively manage and run multiple instruments installed and connected to your PC or your Network—or even over the internet. This software can be found in the Start menu under the WinDAQ program group called Dataq Instruments Hardware Manager. Access WinDAQ Acquisition software, Upload data from your memory card, check the Status of your memory card, Format your memory card, configure a Stand-alone data acquisition session, setup the Digital I/O, and more in this easy-to-use point and click environment. View the Help files by clicking on View Help in the Help menu or by pressing F1.
Help
All WINDAQ software utilizes context-sensitive help. Help may be accessed through the Help menu or by pressing the F1 key with any feature selected. This will take you directly to the Help topic most relevant to that particular function or feature. Help topics discuss in detail each function available in the software.
2. Specifications

Unless otherwise noted, specifications are for all DI-710 instruments.

**Analog Inputs**

Number of Channels: DI-710: 16

Channel Configuration: DI-710: 16 single ended, 8 differential, programmable per channel

Input Impedance, single-ended: 1MΩ

Input Impedance, differential: 1MΩ each input to common

Input bias current: 10µA for a 10V input, single channel

Input offset voltage: Auto-zero

Input offset current: 2nA (single channel)

Maximum normal mode voltage (DI-710): 30V DC or peak AC

Maximum common mode voltage: 30V DC or peak AC

Common mode rejection (DI-710): 80db, gain=1, 1KΩ unbalance

Channel-to-Channel crosstalk rejection: -75db @ 100Ω unbalance

Gain temperature coefficient: 50ppm/°C

Offset temperature coefficient: 0.25µV/°C

Digital Filtering: PC-connected models: Conditional over-sampling

Stand-alone models: None

Analog measurement range (software selectable per channel), Accuracy, and Resolution:

<table>
<thead>
<tr>
<th>Gain</th>
<th>Range</th>
<th>Accuracy*</th>
<th>Resolution</th>
<th>Gain</th>
<th>Range</th>
<th>Accuracy*</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>±10V</td>
<td>±0.05%FSR ±50µV</td>
<td>±1.22mV</td>
<td>1</td>
<td>±10V</td>
<td>±0.05%FSR ±50µV</td>
<td>±1.22mV</td>
</tr>
<tr>
<td>10</td>
<td>±1V</td>
<td>±0.05%FSR ±50µV</td>
<td>±122µV</td>
<td>2</td>
<td>±5V</td>
<td>±0.05%FSR ±50µV</td>
<td>±610µV</td>
</tr>
<tr>
<td>100</td>
<td>±100mV</td>
<td>±0.05%FSR ±50µV</td>
<td>±12.2µV</td>
<td>4</td>
<td>±2.5V</td>
<td>±0.05%FSR ±50µV</td>
<td>±305µV</td>
</tr>
<tr>
<td>1000</td>
<td>±10mV</td>
<td>±0.05%FSR ±50µV</td>
<td>±1.22µV</td>
<td>8</td>
<td>±1.25V</td>
<td>±0.05%FSR ±50µV</td>
<td>±153µV</td>
</tr>
</tbody>
</table>

*Test Condition: Single channel, 100 S/s, averaging mode.

**Digital I/O**

Channels: 8 bi-directional bits

Configuration: Each bit is programmable as an input or output

Output voltage levels: Minimum “1”, 3V @ 2.5mA sourcing; Maximum “0”, 0.4V @ 2.5mA sinking

Output current: Maximum source, -2.5mA; Maximum sink, 2.5mA

Input voltage levels: Minimum required “1”, 2V; Maximum allowed “0”, 0.8V

**A/D Characteristics**

Type: Successive Approximation
Resolution: 14-bit
Monotonicity: ±2 LSB
Conversion Time: 69µs

**Scanning Characteristics**
Maximum sample throughput rate:* PC-connected: 4,800 Hz  Stand-alone: 14,400 Hz**
*When acquiring more than one channel at a gain of 100 max throughput is 7200 Hz;
When acquiring more than one channel at a gain of 1000 max throughput is 900 Hz.
**Dependent on SD card used. Low speed SD cards can sample up to 2,000 Hz; High
speed cards can sample up to 14,400 Hz. Some high speed cards cannot sample as
high at 14,400 Hz but their capability can only be determined by trial and error
(Model 101014-2G has been tested and approved).
Minimum sample throughput rate: PC-connected: 0.0034 Hz  Stand-alone: 0.0017 Hz
Maximum scan list size: 17 entries
Sample buffer size: 2kb

**Calibration**
Calibration Cycle: One year

**USB Interface**
Connector: USB
Protocol: USB 1.1

**Ethernet Interface**
Type: 10/100Base-T
Connector: RJ-45
Protocol: TCP/IP
Server Type: DHCP

**Removable Memory (Stand-alone Models only)**
Type: Standard Secure Digital (not SDHDor SDxC). Sample rates of 2kHz
require SD speeds of 133x or higher. Up to 2kHz require speeds of 13x
or higher.
Capacity: 16MB to 2GB

**Real Time Clock**
Type: Date, hour, minute, second
Resolution: 1 second
Accuracy: 20 ppm

**Controls (Stand-alone Models only)**
Single push-button: Provides manual control over Record and Standby modes.
### Indicators

**Stand-alone models:** Three color LED indicating Record, Standby, and Error conditions.

**PC-connected models:** Power LED

### Transfer Rate to PC

<table>
<thead>
<tr>
<th>Mode</th>
<th>Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Real Time</strong></td>
<td>up to 4,800 samples per second</td>
</tr>
<tr>
<td><strong>From SD Memory</strong></td>
<td>up to 2,400 samples per second</td>
</tr>
<tr>
<td>(Ethernet models</td>
<td>only)</td>
</tr>
</tbody>
</table>

### General

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Panel Indicators:</strong></td>
<td>Mode LED</td>
</tr>
<tr>
<td><strong>Panel Controls:</strong></td>
<td>Control push-button (Stand-alone models)</td>
</tr>
<tr>
<td><strong>Panel slots:</strong></td>
<td>Accepts SD-type flash memory</td>
</tr>
<tr>
<td><strong>Input connectors:</strong></td>
<td>DI-710: Two, removable sixteen position terminal blocks</td>
</tr>
<tr>
<td><strong>Operating Environment:</strong></td>
<td>0°C to 70°C</td>
</tr>
<tr>
<td><strong>Enclosure:</strong></td>
<td>DI-710: Aluminum base with steel wrap-around.    Aluminum end-panels with plastic bezels.</td>
</tr>
<tr>
<td><strong>Dimensions:</strong></td>
<td>DI-710: 5.4 D x 4.1 W x 1.5 H in. 13.81D x 10.48W x 3.81H cm.</td>
</tr>
<tr>
<td><strong>Weight:</strong></td>
<td>DI-710: 14 oz. 397 grams</td>
</tr>
<tr>
<td><strong>Power Requirements:</strong></td>
<td>DI-710 USB products: 9 to 36 VDC, 2 watts maximum</td>
</tr>
<tr>
<td></td>
<td>DI-710 Ethernet products: 9 to 36 VDC, 2.5 watts maximum</td>
</tr>
</tbody>
</table>
3. Installation

Unpacking
The following items are included with each instrument. Verify that you have the following:

- DI-710 Series Instrument.
- Communications cable (USB ONLY - Ethernet models do not come with an Ethernet cable).
- Power cable (except DI-710-UL and DI-710-UH).
- The \textit{DATAQ Instruments} CD-ROM.
- DATAQ screwdriver for connecting signal leads to the screw terminal(s).
- Installation Guide pamphlet (included in CD case).

If an item is missing or damaged, call DATAQ Instruments at 330-668-1444. We will guide you through the appropriate steps for replacing missing or damaged items. Save the original packing material in the unlikely event that your unit must, for any reason, be sent back to DATAQ Instruments.

USB Device Installation
1. Disconnect all DATAQ Instruments USB devices from your Computer.

2. Insert the \textit{DATAQ Instruments CD} in your drive. The installation software should start automatically within 20 seconds. If it does not, start it manually by double-clicking the Setup application (setup.exe) located on the root of the \textit{DATAQ Instruments CD}.

3. In the “What do you want to do?” window, select “Install WinDaq Software” and click \textbf{OK}.
4. In the “Installing Software” window, select the “Install Software for DI-148, DI-158, DI-710, DI-715B, and DI-718B(x) instruments” option and click OK.

5. In the “WinDaq Installation” dialog box, select the “Install Software” option and click OK to continue. If you wish to view the hardware documentation you may do so now by clicking on the appropriate radio button. Documentation will be saved to your hard drive during this installation.

6. In the “Welcome!” box, click OK to continue.

7. Read the License Agreement. If you accept the terms, click Accept and Continue. If you choose not to accept, click on the Do not accept and stop button to end the installation.

8. When prompted, enter your registration information (name and company) in the appropriate text boxes and click OK. Confirm your registration information before continuing.

9. When prompted, specify the directory where you want to install your WinDaq software. It is recommended that you accept the default. If you have already successfully installed a DI-148, DI-158, DI-710, DI-715B, or DI-718B instrument be sure to install to the same folder.

10. In the “Select an Interface” box select USB and click OK.

11. DO NOT connect your USB device or cable to your PC until installation is complete. If your device is currently connected, please disconnect it before continuing with this installation. Once your device is disconnected, click the OK button.

12. When prompted to Select a Program Manager Group specify a destination (or group window) in the Start Menu for WinDaq software icons. It is recommended that you accept the default.

13. In the “Installation Option” dialog box specify whether you want all users to have access to WinDaq software or just the current User. Click Yes to allow all users to have access, click No to allow just the current user to have access.

14. After WinDaq Software installs, you will be prompted to install WinDaq/XL Trial Version and Advanced CODAS Analysis software. If you wish to install either software click on Yes in the appropriate dialog box. Follow the on screen prompts to complete installation.

15. Software installation is complete - you will now see a “Successful Installation” box - click OK to exit WinDaq Installation.

You can now plug the device(s) into your PC and apply power (if required). You do not need to re-install this software when installing more DI-71x USB devices to your PC.

Click on the appropriate program group (specified above — default is Start > Programs > WinDaq) and click on “DATAQ Instruments Hardware Manager” to run WinDaq software. All DATAQ Instruments software is located in the same program group.

**Ethernet Device Installation**

Install WinDaq Software and the DATAQ Instruments Hardware Manager.

1. Insert the *DATAQ Instruments CD* in your drive. The installation software should start automatically within 20 seconds. If it does not, start it manually by double-clicking the Setup application (setup.exe) located on the root of the *DATAQ Instruments CD*.

2. In the “What do you want to do?” window, select “Install Software” and click OK.
3. In the “Installing Software” window, select the “Install Software for DI-148, DI-158, DI-710, DI-715B, and DI-718B(x) instruments” option and click **OK**.

4. In the “WinDaq Installation” dialog box, select the “Install Software” option and click **OK** to continue. If you wish to view the full hardware documentation you may do so now by clicking on the appropriate radio button. Documentation will be saved to your hard drive during installation.

5. In the “Welcome!” box, click **OK** to continue.

6. Read the License Agreement. If you accept the terms, click **Accept and Continue**. If you choose not to accept, click on the **Do not accept and stop** button to end the installation.

7. When prompted, enter your registration information (name and company) in the appropriate text boxes and click **OK**. Confirm your registration information before continuing.

8. When prompted, specify the directory where you want to install your WinDaq software. It is recommended that you accept the default. If you have already successfully installed a DI-148, DI-158, DI-710, DI-715B, or DI-718B instrument be sure to install to the same folder.

9. In the “Select an Interface” box select the **Ethernet** option and click **OK** to continue.

10. When prompted to Select a Program Manager Group specify a destination (or group window) in the Start Menu for WinDaq software icons. It is recommended that you accept the default.

11. In the “Installation Option” dialog box specify whether you want all users to have access to WinDaq software or just the current User. Click **Yes** to allow all users to have access, click **No** to allow just the current user to have access.

12. After WinDaq Software installs, you will be prompted to install WinDaq/XL Trial Version and Advanced CODAS Analysis software. If you wish to install either software click on **Yes** in the appropriate dialog box. Follow the on screen prompts to complete installation.

13. Installation is complete - you will now see a “Successful Installation” box - click **OK** to exit WinDaq Installation.

Ethernet devices can now be connected to your network or PC. Follow the appropriate instructions in “Installing an Ethernet Device Directly Connected to your PC or Connected via a Hub or Switch Where ONLY DI-71x Products are Installed” on page 12 “Installing an Ethernet Device via a Distributed Network Without a DHCP Server” on page 15, or “Installing an Ethernet Device via a Distributed Network with a DHCP Server” on page 16 of this manual for your specific network connections configuration.

Click on the appropriate program group (specified above — default is Start > Programs > WinDaq) and click on “DATAQ Instruments Hardware Manager” to run WinDaq software. All DATAQ Instruments software is located in the same program group.
Installing an Ethernet Device Directly Connected to your PC or Connected via a Hub or Switch Where ONLY DI-71x Products are Installed

Installation of an Ethernet device directly connected to the network card on your computer requires you to change the IP address of your network card.

**Note:** When installing an Ethernet device directly connected to your PC you **MUST** use a crossover cable (provided). When using a hub that does not have an auto-switching sensor, you must **NOT** use a crossover cable.

**Note:** You **MUST** disable all wireless connections during installation. Wireless connections can be re-enabled once installation is complete.

Installation of an Ethernet device via an Ethernet hub/switch containing ONLY DI-71x products also requires you to change the IP address of your network card.

**Note:** For hubs that do not have an auto-switching sensor (usually older hubs) you must **not** use a crossover cable.

1. Install software (see “Ethernet Device Installation” on page 10).

1. Find the **Network Connections** on your computer (usually in the **Control Panel**).

2. Double-click on the **Local Area Connection** icon.

<table>
<thead>
<tr>
<th>Local Area Connection</th>
<th>Local Area Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connected, Firewalled Intel(R) PRO/100 VE Network...</td>
<td>Network Realtek RTL8168C(P)/8111C(P) Fa...</td>
</tr>
</tbody>
</table>

| Windows XP | Windows 7 |

3. Click on the **Properties** button.
4. Select Internet Protocol (TCP/IP) (in Windows XP) or Internet Protocol Version 4 (TCP/IPv4) (in Windows 7) in the “This connection uses the following items” window and click on the Properties button.

5. Click on the General tab.

6. Select the radio button Use the following IP address.

7. Enter 169.254.0.1 in the space provided for the IP address.
8. Enter 255.255.255.0 in the space provided for the Subnet mask.

![Internet Protocol (TCP/IP) Properties dialog box]

9. Click on the **OK** button to close the *Internet Protocol (TCP/IP) Properties* dialog box then click on the **OK** button in the *Local Area Connection Properties* dialog box for the changes to take effect.

10. You will now be able to see the device in the DATAQ Instruments Hardware Manager (you may have to click on the **Update List** button).

**NOTE:** If you unplug your device and connect your PC to a network or router you should change these settings back to their original state.
Installing an Ethernet Device via a Distributed Network Without a DHCP Server

Installation of an Ethernet device connected to a distributed network that does not have a DHCP server or where the DHCP server is turned off requires you to obtain an IP address from your system administrator.

**Note:** In the illustration above, the Hubs could instead be routers with DHCP turned off (i.e., a static IP assigned network). Contact your system administrator for details about your network.

1. Have the system administrator designate an IP address for your device.
2. Install software (see “Ethernet Device Installation” on page 10).
3. Plug the device into your network and apply power.
4. Open the DATAQ Instruments Hardware Manager software.
5. In the dropdown command list (lower left-hand corner), select Static IP. The Manage IP Addresses dialog box will open.
6. Click on the MAC address of your device in the list of displayed MAC addresses (the MAC address of your device can be found on the silver sticker located on the bottom of your device).
7. Enter the IP address your system administrator assigned to you in the New IP Address text boxes.
8. Click on the Set Static button. Your device will appear in the list of available devices in the main DATAQ Instruments Hardware Manager window. It may take more than 15 seconds for your device to appear in the list. If you get a “No Devices Found” error after following the above instructions, click the Update List button until the device appears in the list.

**Note:** These instructions change the settings inside the device. If you move the device to a DHCP-enabled network (i.e., where IP addresses are assigned automatically by a DHCP server or router) you will need to change the device settings using the DATAQ Instruments Hardware Manager. See the DATAQ Instruments Hardware Manager help file for complete details.
Installing an Ethernet Device via a Distributed Network with a DHCP Server

Installation of an Ethernet device connected to a distributed network that has a DHCP server (i.e., a DHCP router automatically assigns IP addresses to each device connected to the network) requires no extra setup (i.e., it is a “plug and play” device).

**Note:** If you are unsure whether your network is DHCP-enabled or not, check with your system administrator before installing WINDAQ.

1. Install software (see “Ethernet Device Installation” on page 10).
2. Connect your Ethernet device to your Local Area Network.
3. Apply power to the device.
4. You will now be able to see the device in the DATAQ Instruments Hardware Manager (you may have to click the **Update List** button).

**Activation of WINDAQ/High Speed Option**

Activation is required for continued use of WINDAQ/HS (High Speed option) to ensure compliance with the Software License Agreement. The Software License Agreement can be found in the WINDAQ Software manual or in the WINDAQ program group (License.txt). The WINDAQ/HS may be activated through the **Help** menu by clicking on **Unlock WINDAQ/HS** or by waiting for the trial version to expire. Trial versions are good for 40 High Speed (over 1108 Hz throughput) recording sessions. The High Speed version may be purchased after the trial period expires through our online store or by phone. For help or for questions regarding Activation and/or the Software License Agreement, contact DATAQ Instruments Customer Support.

**Dataq Instruments Hardware Manager**

The Dataq Instruments Hardware Manager is installed when installing any DI-710 instrument. This software allows you to effectively manage and run multiple instruments installed and connected to your PC or your Network—or even over the internet. WINDAQ Data Acquisition Software and the Stand-alone Set Up program are both accessed.
through the Dataq Instruments Hardware Manager. The Dataq Instruments Hardware Manager may be accessed through the Windows Program Manager Group as specified during installation (default is Start > Programs > WINDAQ > Dataq Instruments Hardware Manager). All available devices will automatically appear in the list box when you run the software. For help with the Dataq Instruments Hardware Manager access the Help Files using either the Help menu item or by pressing the F1 key to access context-sensitive help.
4. Instrument Controls, Indicators, and Connections

Connecting the DI-710 to Ground

! IMPORTANT !

The ground connection on the I/O terminal strip should always be connected to a signal ground, if one is not inherently made through analog or digital signal connections. Without this connection, the front end of the DI-710 does not have a return path which could lead to inaccurate measurements. Under no circumstances should the DI-710 be used in a measurement situation where it will experience common mode voltages in excess of ±30 VDC or peak AC (the device’s full-scale range without damage).

The ground lug at the rear of the DI-710 should always be connected to a solid chassis or earth ground. This connection is mandatory for the unit to meet CE guidelines.
Instrument Front Panel

The 32 port screw terminal access connector is used to interface analog input channels 1 through 16 and the eight digital bits. Use the sticker located on the top of your instrument for quick reference to terminal access port designations. Designations are explained in full detail here.

DI-710 Series instruments can accept 16 analog inputs in single-ended configuration or 8 analog inputs in differential configuration. Single-ended inputs are configured by connecting one signal lead to the desired channel and the other signal lead to analog ground (AG). Be sure to read “CAUTION” on page v before connecting input signals.

DI-710 Series Hardware Manual
Differential inputs occupy two channels with the lowest numbered channel in the pair assuming the positive (+) input and the channel number. Refer to the following for differential pairs.

For example, to configure Channel 1 as a differential input: Connect Channel 1 as the positive (+) input and channel 9 as the negative (-) input—the pair is referred to as “channel 1 differential.” The following illustration shows channels 1 and 9 configured as channel 1 differential.

**37-pin D sub connector**

The two removable 16-port screw terminal blocks may be replaced by a 37-pin D Sub Connector for all DATAQ Instruments DI-710 Series products (add a “D” to the model number). Refer to the following diagram for pin out.

**Note:** Digital I/O connections cannot be used concurrently. DI0 and DO0 are directly connected inside the DI-710 (as are DI1 and DO1, DI2 and DO2, etc.).

Refer to “7. Accessories” for accessories that can be used with the 37 pin D sub connector.
Instrument Rear Panel

The Rear panel of your DI-710 Model can vary depending on your model. Stand-alone models add a removable storage slot, the LED Mode table, and a Control Button.

Connecting Signals

Use the removable screw terminal blocks to connect your signals.

1. Insert the stripped end of a signal lead into the desired terminal directly under the screw.

2. Tighten the pressure flap by rotating the screw clockwise with a small screwdriver. Make sure that the pressure flap tightens only against the signal wire and not the wire insulation. **Do not over-tighten.**
3. Tug gently on the signal lead to ensure that it is firmly secured.

When an input signal is connected and WinDAQ Acquisition software is run, WinDAQ’s real time display immediately reveals the input waveform on your computer’s monitor.

### Controls and Indicators

**Power Input Jack**
For Ethernet models and Stand-alone models. Power must be applied with the included power adapter or with an alternate appropriate source (9-36 VDC, 2 watts max). External power is not required for DI-710-UH and DI-710-UL models—Power is derived through one of your PC’s USB ports or through a powered USB hub.

**Ground**
This ground lug should always be connected to a solid chassis or earth ground. This connection is mandatory for the unit to meet CE guidelines.

**Interface Port**
The Interface port allows you to connect the instrument to your PC via USB or Ethernet cable.

**Control Button (Stand-alone Models)**
The Control Button can be used to stop or start recording data to your memory card (SD) when using the instrument as a stand-alone data logger. The Control Button can also be used to reconfigure the instrument to factory default settings and to re-format memory card files left open due to power failure or other circumstance. The Control Button is inoperable while running WinDAQ Acquisition software.

**Start Recording**
To Start recording data to your memory card the Instrument must be in Standby Mode (Mode LED is Green). Press and hold the Control Button until the Mode LED turns off (about 1 second). Release the Control Button. The Mode LED will rapidly blink green to indicate the instrument is creating a new file. When the Mode LED slowly blinks red, data is being recorded. Each subsequent recording session creates a new file (numbered sequentially).

**Stop Recording**
To Stop recording data to your memory card the Instrument must be in Record mode (Mode LED is flashing red @ 1 Hz). Press and hold the Control Button until the Mode LED turns off (about 1 second). Release the Control Button. Mode LED will rapidly blink red to indicate the instrument is closing the data file for use with playback and/or analysis software. Do not remove the memory card before the instrument completely closes the file. When Mode LED turns green the memory card may be removed. Removing the card before completion will cause Error Mode (Mode LED is orange).
**Note:** SD cards should be locked before inserting into a card reader. Your PC may try to change the flash card format whenever it reads the data on your SD card (if not locked), causing it to lose the unique formatting required for DI-710 use. If the unique format used by the DI-710 is modified, the data logger may require you to reformat the memory card.

**Formatting the Memory Card**
Formatting the card completely removes all data. To format your memory card the instrument must be in Standby Mode (Mode LED is Green). Press and hold the Control Button until the Mode LED turns red (about 5 seconds). Release the Control Button. The Mode LED will blink red to indicate the Instrument is formatting the card. When the Mode LED changes back to green, formatting is complete. Mode LED should be green to indicate successful completion. Formatting is for use with the instrument used to format the card. To use a memory card with a different instrument you will have to reformat the card.

**Reconfigure Instrument**
To configure your instrument to the default factory data acquisition session settings press and hold the Control Button during power up (i.e., while plugging the instrument in). Mode LED will flash bright green then dim to indicate that the instrument is configured. Release the Control Button. The default settings are: 16 channels enabled as single-ended inputs; 300 samples per second per channel sample rate; gain setting of 1 for each channel.

**Fix Errors**
The Control Button can also be used to fix some common operating errors. When the instrument is in Error mode, some action must be taken to fix the error before you can use it. Generally, the Control Button can be used to make the instrument operational. See the Error mode in “Mode LED Indicator” on page 25 for more information.
**Mode LED Indicator**

Indicates what mode the instrument is currently in. Use the chart on the rear panel of the instrument for quick reference. Use the table provided below for a more detailed description of each available state.

<table>
<thead>
<tr>
<th>State</th>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Stand-alone data logger operation</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Static Green</td>
<td>Standby</td>
<td>Instrument is powered and available for data acquisition operations. Memory card may be safely removed.</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>Busy</td>
<td>Indicates the instrument is busy. Do Not Remove Memory Card.</td>
</tr>
<tr>
<td>Orange</td>
<td>Error</td>
<td>Possible errors include, but are not limited to:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>SD removed prematurely:</strong> Memory card removed before the instrument had a chance to close the data file. Reinsert the card and Press the Control button to close the file. When steady green, memory card is closed and can be removed safely.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>SD Lock:</strong> After initially pressing the Control button to begin recording data, two series of blinking Orange before reverting back to Green indicates that the memory card is locked. Use another card or unlock the current one. One series of blinking Orange before reverting back to Green indicates that the memory card is incompatible for use with the instrument. Use the recommended memory card available through DATAQ Instruments, Inc. See also “Troubleshooting” on page 29.</td>
</tr>
<tr>
<td>Slow Flashing Red (@ 1Hz)</td>
<td>Record</td>
<td>Indicates the instrument is acquiring and recording data to your memory card. Do Not Remove Memory Card.</td>
</tr>
<tr>
<td>Fast Flashing Red</td>
<td>Close</td>
<td>Indicates the instrument is closing the recording session. Do Not Remove Memory Card. Each recording session must be completed before removing the card.</td>
</tr>
<tr>
<td><strong>PC-connected operation</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slow Flashing Red (@ 1Hz)</td>
<td>Record</td>
<td>Indicates the instrument is running and acquiring data for display and/or recording to disk. Occurs when WINDAQ Acquisition is running.</td>
</tr>
<tr>
<td>Green</td>
<td>Standby</td>
<td>Indicates WINDAQ has been deactivated and the instrument is in Standby Mode. The Mode LED Indicator will also flash green just before recording to disk to indicate initialization.</td>
</tr>
</tbody>
</table>

**Removable Storage Slot (SD) (Stand-alone Models)**

Use any standard Secure Digital Card (SD) from 16MB to 2GB. Push card completely into slot. Press to release (eject) memory card when recording is complete. Please note that some memory cards may not be fast enough for the instrument. SD memory cards are available through the DATAQ web site (www.dataq.com) as are SD card readers (manufacturer varies).
5. Operation

PC-connected Models

PC-based models (non-Stand-alone) are operated and controlled using WinDAQ Software. To begin displaying data on your monitor, make sure all wires and cables are properly connected and start WinDAQ Acquisition by pressing the Start WinDAQ button in the Dataq Instruments Hardware Manager (see “Dataq Instruments Hardware Manager” on page 16). After data is recorded, use WinDAQ Waveform Browser to review your data. Consult the context-sensitive help files or your Fast Start WinDAQ Software Manual for directions on using the WinDAQ software package. Note: If your USB module experiences frequent lock ups connect the Ground Lug to your PC ground. If the problem persists please contact Technical Support.

Enabling/Disabling the Digital I/O and Remote Control

To use the Remote Control features in WinDAQ Acquisition Software Channel 1 or Channel 17 must be enabled as the Digital Input channel. In order to use all 16 analog input channels, Channel 17 may be enabled for general purpose digital I/O functions. The direction of the digital bits must be set in the DATAQ Instruments Hardware Manager using the Digital I/O Setup command. The default state from the factory is that all digital bits are set as Inputs with a High signal (+5V).

Stand-alone Models

Stand-alone Models can record data directly to a Secure Digital Card (SD) as well as record data to a PC. When connected to a PC, data recording sessions may be configured and data may be acquired using WinDAQ Acquisition software (just the same as if the model were a PC-based instrument). This makes all the features of WinDAQ Acquisition software available including triggering, user annotation, user commented event markers, appending, and stop/pause data recording (stand-alone data logger operation does not support these features).

When taking your stand-alone model out into the field to use as a stand-alone data logger, you can record data to an SD without the use of a PC. Data sessions can be configured for a specific job using the included configuration software (installed when WinDAQ is installed). All data recorded to the memory card is fully WinDAQ compatible and can be converted then reviewed and analyzed with WinDAQ Playback software.

PC-connected operation

The DI-710 Instrument enters PC Operation Mode when the instrument is connected to the PC and the user initiates WinDAQ Acquisition software. As soon as PC Operation Mode is entered, the Control button is deactivated and all the features of WinDAQ Acquisition Software are accessible. Consult the context-sensitive help files or your Fast Start WinDAQ Software Manual for directions on using the WinDAQ software package.

Note: When running WinDAQ Acquisition software over the internet, unpredictable latencies may occur, especially at higher sample rates. The unit generally will continue to acquire data after a latency - but there will be gaps in your data.

Networked operation as a data acquisition server

The Ethernet option allows data access from anywhere on a local area network (LAN) or DHCP server. A DI-710 configured for Stand-alone operation and an Ethernet interface transparently becomes like any other computer on the network, able to share data whenever and wherever it is needed. This can be over the LAN to a PC on the other side of the facility, or over the Internet to a PC on the other side of the world. Furthermore, Stand-alone instruments can be easily added to existing networks. Its server functionality means that it does not require a dedicated network to operate efficiently. Data is locally stored to SD memory, where it is available for upload (using the Uploader software) only on demand and as network bandwidth permits. In this manner, Stand-alone instruments with Ethernet interfaces are fully compatible with the intrinsic non-preemptive nature of Ethernet networks.
Stand-alone data logger operation

Use your Stand-alone model as a stand-alone data logger to record a WinDaq-compatible waveform file onto a Secure Digital Card (SD). After recording, insert the memory card into your card reader to access the data file. The data file can then be opened with WinDaq Waveform Browser Software for SD allowing analysis and review features. See “WinDaq Waveform Browser for SD” on page 30 for more information regarding WinDaq Waveform Browser for SD software.

Data may be recorded using a circular FIFO memory configuration allowing you to record data nearly indefinitely or in a non-circular configuration allowing you to stop recording when your memory card is full. Select the desired memory configuration using the Stand-alone Set Up software inside the Dataq Instruments Hardware Manager.

Note: SanDisk SD memory cards have a lifetime expectancy of about 100,000 write actions. Each time data wraps you will use one write action; each singular data file uses two write actions (start and stop). If used properly a memory card will last years. See your memory card’s specifications to determine lifetime expectancy.

The Stand-alone Set Up Panel

The Stand-alone Set Up software (installed with WinDaq—accessible in the WinDaq program group through the Dataq Instruments Hardware Manager) allows you to customize each data recording session before taking the instrument out into the field. The default settings (i.e., if you do not configure the instrument) are 16 single-ended channels enabled at 300Hz sample rate and a gain of 1. The default configuration can be reset at any time on the instrument by holding the Control button in when applying power. Context-sensitive Help is provided within the configuration software. Press F1 to access Help topics related to the currently displayed feature. You must run the software with the device properly installed and connected to your PC.

Operation

To use your instrument as a stand-alone data logger follow these steps:

1. Configure the Instrument using the Set Up software or by re-setting to the default (See “The Stand-alone Set Up Panel” above).
2. Connect signal leads (See “4. Instrument Controls, Indicators, and Connections” on page 19).
3. Apply Power to the instrument using the supplied Power Cable.
4. Insert the Secure Digital Card (SD) into the Removable Storage Slot.
5. If the memory card has not been used with your instrument, format the memory card to begin recording data. See “Formatting the Memory Card” on page 24.
6. To Record Data to memory card: Press and hold the Control Button until the LED light turns off; release the Control button to initiate the recording session—initialization could last up to 30 seconds depending on memory card used. For Ethernet models you may also use the Start Recording to SD Memory command in the DATAQ Instruments Hardware Manager. This creates a new file numbered sequentially on the memory card. See also “Start Recording” on page 23.
7. To Stop Recording Data to memory card: Press and hold the Control Button until the LED light turns off; release the Control button to end the recording session and close the data file. It could take up to 30 seconds to close the file depending on the memory card used. For Ethernet models you may also use the Stop Recording to SD Memory command in the DATAQ Instruments Hardware Manager. See also “Stop Recording” on page 23.
8. Access SD data using the uploader software provided in installation (Ethernet models) or by removing the memory card and using a card reader. Data files open in WinDaq Waveform Browser for SD (see “WinDaq Waveform Browser for SD” on page 30).
**Note:** To read the data files, SDs should be locked before inserting into a card reader. If the SD is not locked, Windows may modify the file system and the SD will be unreadable to your instrument requiring you to reformat the card. Some cards may require you to reformat every time you review the data.

**Troubleshooting**

Use the following chart for errors and resolution.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause(s)</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>When attempting to initiate a recording session the LED blinks green for about 5-10 seconds then quickly blinks orange then back to green.</td>
<td>Memory card not inserted.</td>
<td>Press memory card firmly into the slot until you hear a slight “click” to indicate proper insertion.</td>
</tr>
<tr>
<td>When attempting to initiate a recording session, LED blinks orange, then turns green.</td>
<td>SD is locked (write protected).</td>
<td>Unlock the SD Card</td>
</tr>
<tr>
<td></td>
<td>Memory card is full.</td>
<td>Reformat the memory card.</td>
</tr>
<tr>
<td></td>
<td>Memory card is unusable or damaged.</td>
<td>You need a new memory card.</td>
</tr>
<tr>
<td>Recording is initiated but only runs for a short time when LED blinks orange and stays orange.</td>
<td>Memory card read/write speed in SPI mode is too slow to record data as specified.</td>
<td>Try lowering the sample rate first. If problem persists purchase a new card (recommended: Lexar Professional 133X 2 Gigabyte Secure Digital Flash Memory).</td>
</tr>
<tr>
<td>Recording is initiated in Circular Memory configuration, but when the file attempts to wrap, the LED blinks orange and stays orange.</td>
<td>Memory card read/write speed in SPI mode is too slow to record data in circular memory configuration.</td>
<td></td>
</tr>
<tr>
<td>LED is green but I cannot format a memory card.</td>
<td>The instrument is looking for a file that has not been closed (possible due to power failure).</td>
<td>Reinsert the correct memory card and press the control button for about 1 second (until LED turns off) and release. The instrument gives you three chances to find the correct file, if it does not you must format whatever card is there to begin a new recording session.</td>
</tr>
<tr>
<td>Mode LED will not change from error state (orange).</td>
<td>This can be caused by switching memory cards during a power failure without giving the instrument a chance to close the data file.</td>
<td>Remove the memory card and unplug the device. Restore power to the device (LED should turn green). Press and hold the control button for about 1 second (until LED turns off) and release. If LED is orange, press it again. When LED turns green reformat your memory card.</td>
</tr>
<tr>
<td>When memory card is inserted into a reader a “not formatted” error is seen.</td>
<td>Dependent upon the reader being used.</td>
<td>Sometimes the driver for an SD card reader appears “dead.” Reboot your PC.</td>
</tr>
<tr>
<td>When attempting to read the memory card using a card reader, the PC takes an interminably long time to open the data.</td>
<td>Dependent upon the memory card, card reader, and the PC you are using. The amount of time it takes to open the card will vary.</td>
<td>Using the Lock feature on an SD could speed up the process. Be sure to try that before purchasing new equipment.</td>
</tr>
</tbody>
</table>
If power down occurs unexpectedly while recording to SD

The Stand-alone models have a built-in file protection feature. If power is lost while recording, all data—prior to up to 255 samples from the power failure—is available. If power is lost for any reason, the data file will be closed and saved and a new data file will be started when power is restored (Mode LED will flash red @ 1 Hz) if that option is selected in the Hardware Manager Stand-alone setup.

If the memory card is full, the Mode LED will quickly flash orange and then green and will not record new data until reformatted. Circular memory configuration may still be used if the memory card has not started to wrap the data (i.e., as long as the card is not full) and will only wrap data in the available space.

When recording at low sample rates be aware that the memory card must acquire 256 samples before it actually commits them to memory. For example, if you are recording one channel at 1 sample per second and power down occurs unexpectedly, you could lose up to 255 seconds (4 minutes and 15 seconds) of data (255 samples). Use the following formula to determine the maximum amount of data loss at power failure.

\[
\frac{255}{\text{Throughput Rate}} = \text{Seconds of data that COULD be lost}
\]

Note: Clean and solid power on/off (no slow charging and no ringing) required for new file on power interruption. Once power is on, power interrupt cannot happen again within 5 seconds. If persistent failure upon power interruption occurs, consider a universal power supply (UPS).

Note: Switching memory cards before power is restored is not suggested because the data logger will automatically attempt to close the file. Leave the memory card in until power is restored, then allow the instrument to close the data file. After a new file has begun, stop recording. The memory card may now be removed and read for analysis.

WINDAQ Waveform Browser for SD

All files recorded in Stand-alone data logger operating mode (data saved to SD—.wdc files) must be reviewed in WINDAQ Waveform Browser for SD. Data files recorded using WINDAQ Acquisition software (PC operation—.wdq files) must be reviewed in the standard WINDAQ Waveform Browser. Even if connected to a PC, WINDAQ Waveform Browser cannot eavesdrop on the data being recorded to your memory card. Recording must be stopped and the file must be closed to review the data.
DI-710 stand-alone data loggers place 256 equally-spaced event markers into all data files when recording to SD. This allows easier navigation through larger files. Click on **Event Markers** in the **View** menu to access and “jump to” each of these event markers.

The **Calculate** command in the **File** menu is unavailable in WinDAQ Waveform Browser for SD. Use the **Save As...** command in the **File** menu to save data to another format in order to perform Advanced CODAS calculations (**File > Save As...** > option 8) **CALC** is still available). Converting data from a .wdc format to a .wdq format is also possible with **File > Save As...**. Choose option 2) **Binary (with CODAS header)** and enter a file name with .wdq as the extension. For more information regarding the Save As... function, consult your WinDAQ Waveform Browser Help File.

A stand-alone data file acquired with remote events or storage enabled displays an hourglass when opening while it scans for event marks and timestamps in order to construct an Event Marker table. Use File Save or the "Save All" button when changing files or exiting to write the Event Marker table to the file and avoid a delay when the file is opened again.
6. Block Diagram

Block Diagram

*Stand Alone Models Only*
7. Accessories

The DI-705 (for use with DI-710 “D” models)

The DI-705 plugs into the 37-pin D sub connector of the front panel of DI-710 “D” models (see “37-pin D sub connector” on page 21) and provides convenient screw terminal access to analog inputs, analog outputs, and the Digital I/O. Note: The digital I/O is not available in stand-alone mode. The screw terminals accept 16-22 gauge wire and each is silk-screened with the corresponding “D” connector pin number (see “37-pin D sub connector” on page 21). The DI-705 also features a 37-pin male “pass-through” connector, which allows you to connect our BNC cable (model number CABL-4), our 5B back plane cable (model number CABLE-1), or any 37-pin DAS-16 compatible cable to the DI-710 while still allowing screw terminal access.

Any combination of single-ended or differential channels may be connected to the DI-705, but keep in mind a differential channel uses two analog inputs. Configure single-ended and differential channels on the DI-705 the same way as on the DI-710. See “Instrument Front Panel” on page 20 for more information.
The DI-205 (for use with DI-710 “D” models)

The DI-205 is a termination panel for general purpose input and output. The DI-205 along with the supplied cable provides a convenient way to interface the Digital I/O, analog output, and analog input signals to DI-710 Series “D” models (see “37-pin D sub connector” on page 21). Signal connection is via terminal strip for digital and analog output signals, or 5-way binding posts (banana jacks) for analog input signals.

**Input/Output Panel Interconnections**

![Input/Output Panel Interconnections Diagram]

**Digital I/O - Analog Output**

The 20 position screw terminal block (labelled Digital I/O - Analog Output) provides access to the Digital I/O ports of the 37-pin D sub connector. **Note:** Digital I/O connections cannot be used concurrently. DI0 and DO0 are directly connected inside the DI-710 (as are DI1 and DO1, DI2 and DO2, etc.) The Digital I/O is not available in stand-alone mode. See “37-pin D sub connector” on page 21 for pinout.

DAC1 and DAC2 are Reserved ports and should not be used.

VOUT connects to the +5VPWR pin. See “37-pin D sub connector” on page 21 for pinout.
**Input Signal Configuration**

Each DI-205 may be configured to connect to 16 single-ended or 8 differential channels. In addition, any combination of single-ended or differential channels may be applied. A differential channel is configured by using two single-ended inputs. Use the following illustration for input connections.

![Diagram of single-ended and differential input configurations]

Note that when an input channel is configured for differential operation, the binding post associated with that channel's high (+) input assumes the channel number.

**Connecting a Single-ended Amplifier**

A single-ended amplifier is the most straightforward approach to connecting signals to the DI-205. However, to derive adequate performance, the use of a single-ended amplifier requires that the signal to be measured is relatively high level (greater than or equal to 1V full scale), and the distance from the signal source to the DI-205 is relatively short (less than 15 feet). Assuming these conditions exist, a single-ended amplifier may be connected according to the diagram below.

![Diagram of single-ended amplifier connection]
Connecting a Differential Amplifier
A differential channel configuration is a special case approach to signal measurement that should be used with all low-level measurements (less than 1v) or when the signal to be measured is located far away from the DI-205 (greater than 15 feet). When in a differential operating mode, the instrument sees the difference in voltage between the high (+) and low (-) inputs. Differential amplifiers have the advantage of reducing common mode voltages (those appearing simultaneously and in phase on both inputs). This capability may be leveraged to greatly reduce noise riding on a signal of interest.

Two signal measurement conditions govern the configuration of a differential channel input: The signal to be measured is ground-referenced; or the signal to be measured is isolated from ground.

Ground-referenced Signal Sources
A ground-referenced signal source is one with a local ground that may not be (and probably is not) at the same potential as the computer's ground. This potential difference between signal ground and computer ground is referred to as a common mode voltage and is caused by a number of different factors.

The most common of these is different physical locations of the computer and signal ground points. Since wire is not a perfect conductor (exhibiting zero resistance regardless of length) a voltage drop, however small, will always be
The differential amplifier is unique in its ability to measure signals originating from sources with different ground potentials relative to the computer provided it is connected properly.

The most common error made in connecting differential amplifiers is the tendency to ground both ends of a signal shield. This causes current to flow through the shield and induces noise on the signal to be measured. Ensuring that only one ground exists on the signal circuit eliminates this problem.
Isolated Signal Sources

There are two considerations when connecting a differential amplifier to an isolated signal source: The elimination of ground loops as described above, and the use of bias resistors to provide bias current for the differential amplifier's positive and negative inputs.

The bias resistors should be chosen to be as low as possible, but the value you use is dependent upon the output impedance of your signal source. Generally, the value of the bias resistor should be 10 times the output impedance of your signal source or higher. Bias resistors greater than 1MΩ are not recommended.

Signal Cable and the Differential Amplifier

Quick rule-of-thumb: Any application requiring a differential amplifier also defines a need for quality signal cable. Four elements combine to ensure adequate quality signal cable: a twisted signal pair with low resistance stranded copper conductors; surrounded by a multiple-folded foil shield; with a copper stranded drain wire; all contained within an insulated outer jacket.

In applications where such signal cable is used, a dramatic decrease in noise pickup will be experienced. The drain wire should be considered as the shield and should be connected as described in “Connecting a Differential Amplifier” on page 38. Signal cable meeting all four criteria for quality is Belden No. 8641.